BAB Il
ANALISIS DAN PERANCANGAN

I11.1. Analisis Sistem yang Berjalan

Proses yang sedang berjalan dalam penginformasian Lokasi Akper dan
Akbid ini masih bersifat manual. Bentuk manual yang dibuat oleh terkait yaitu
dengan bertanya kepada orang. Banyaknya kendala yang terdapat pada
penginformasian melalui telepon, mengakibatkan Lokasi Akper dan Akbid kurang
diketahui masyarakat luas. Melihat kebutuhan akan informasi tentang Lokasi
Akper dan Akbid merupakan hal yang penting bagi setiap masyarakat yang ingin
mengetahui alamat, lokasi dan fasilitas yang ada pada Lokasi Akper dan Akbid.
Namun kesulitan umum yang sering dialami oleh mayarakat adalah tidak terdapat
informasi yang cukup dan tidak mengetahui alamat dan Lokasi Akper dan Akbid
tersebut. Dalam aplikasi yang dibuat ini akan membantu masyarakat dalam
mendapatkan informasi Alamat dan Lokasi Akper dan Akbid yang ingin
diketahui. Menyajikan sebuah peta yang dapat berinteraksi dengan penggunanya
sehingga dapat memberikan informasi yang lebih akurat. Adapun analisis sistem

ini meliputi input, proses dan output yang dijabarkan sebagai berikut :

111.1.1. Analisis Input
Analisis sistem input yang sedang berjalan pada sistem yang lama adalah

data kampus, data lokasi kampus, data denah Lokasi Akper dan Akbid.

111.1.2. Analisis Process

Proses yang terjadi pada sistem yang dijelaskan pada langkah-langkah:
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Informasi Pencarian Lokasi Akper dan Akbid

Konsumen / pengguna Masyarakat

Informasi lokasi

Mencari lokasi

Y

\ 4

Mengunjungi g Lokasi
akademik - akademik

\ 4

SELESAI

Gambar 111.1. Flow Of Document Lokasi Akademik Perawat dan Akademik
Kebidanan

Phase

Penjelasan FOD :

1. Konsumen / pengguna mencari informasi lokasi Akper dan Akbid kepada

masyarakat.

2. Masyarakat memberikan informasi lokasi Akper dan Akbid kepada konsumen

/ pengguna.
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3. Setelah mendapatkan informasi Lokasi Akper dan Akbid, pengguna
melakukan pengunjungan ke lokasi Lokasi Akper dan Akbid yang mereka

ketahui.

111.1.3. Analisis Output

Output yang dihasilkan dari sistem adalah informasi-informasi Lokasi
Akper dan Akbid yang ada dan mengunjungi Lokasi Akper dan Akbid yang di
inginkan maka Masyarakat akan mendapatkan jasa pelayanan sesuai dengan
kebutuhan Masyarakat yang diberikan oleh pihak Lokasi Akper dan Akbid yang

bersangkutan.

I11.2. Evaluasi Sistem yang Berjalan
Sistem yang sedang berjalan memiliki beberapa kelemahan yang
dijabarkan sebagai berikut:

1. Kurang berkembangnya sistem informasi geografis yang terdapat di Peta.

2. Penyebaran informasi lokasi Akper dan Akbid di kota medan saat ini masih
menggunakan cara konvensional yaitu menggunakan selebaran yang kurang
sesuai dengan era globalisasi.

3. Belum adanya sistem yang dapat membantu masyarakat dalam mencari
informasi lokasi Akper dan Akbid di kota medan.

Penulis membangun sebuah aplikasi informasi geografis dengan
menggunakan aplikasi dreamweaver dan database mySQL dan penulis
memberikan solusi dari perancangan geografis tersebut untuk mengurangi

kelemahan terhadap sistem yang sedang berjalan seperti berikut :
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1. Merancang sistem informasi geografis yang dapat memberikan informasi titik
lokasi Akper dan Akbid di kota medan.

2. Mempermudah dan mempercepat penyebaran informasi lokasi Akper Akbid
di kota medan.

3. Membuat sistem yang dapat memberikan kemudahan bagi masyarakat dalam

mencari informasi lokasi Akper dan Akbid di kota medan.

111.3. Desain Sistem

Desain sistem pada penelitian ini dibagi menjadi dua desain, yaitu desain
sistem secara global untuk penggambaran model sistem secara garis besar dan
desain sistem secara detail.
111.3.1.Desain Sistem Secara Global

Desain sistem secara global menggunakan bahasa pemodelan UML yang
terdiri dari Usecase Diagram, Class Diagram, Sequence Diagram dan , Activity
Diagram.
111.3.1.1. Usecase Diagram

Secara garis besar, bisnis proses sistem yang akan dirancang digambarkan

dengan usecase diagram yang terdapat pada Gambar 111.2 :
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Pembuatan Sistem Informasi Geografis Pencarian Lokasi
Akper dan Akbid di Kota Medan

Lokasi Kampus )----

<extends> (" olah Artikel

<extends>

< cextends>--— nggah Gambai
Kampus
<include>
<extends>
’ Unggah Gambar
Artikel

_ap-
user
List Of Campus

Gambar 111.2. Use Case Diagram Sistem Geografis Lokasi Akper dan Akbid

/

admin

Keterangan :
a. User dapat melihat aktifitas pada campus map, guest book, articles dan list
of campus tanpa harus melakukan login terlebih dahulu.
b. Admin melakukan login terlebih dahulu untuk masuk kedalam sistem dan
melakukan pengolahan data pada lokasi kampus, olah artikel, unggah dan

unggah gambar kampus.

111.3.1.2. Class Diagram
Rancangan kelas-kelas yang akan digunakan pada sistem yang akan dirancang

dapat dilihat pada gambar 111.3 :



thumbnail

-id
-name
-type
-size
-content

+choose file()
+upload()

konten

-kode konten
-tanggal
-terbit

-judul

-isi
-thumbnail

+tambah()
+reset()
+cari data()
+edit()
+delete()

Gambar 111.3. Class Diagram Sistem Informasi GIS Lokasi Akper dan Akbid

gambar komentar
-id -kode komentar
-name -nama
-type -email
-size -tanggal
-content -pesan brosur
+choose file() +kirim() -kode tempat
+upload() +reset() -sejarah
-fasilitas
1 -syarat
| -rincian biaya
-jadwal
kampus -kontak
-kode tempat 1.* +tambah()
-nama kampus +reset()
-alamat +cari data()
-gambar +edit()
-lon +delete()
-lat jalan
-keterangan _kode jalan
+tambah() ! -nama jalan
+reset() -tipe jalan
+cari data() _lon
+edit() -lat
+delete()

111.3.1.3. Sequence Diagram
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Rangkaian kegiatan pada setiap terjadi event sistem digambarkan pada

sequence diagram berikut:

1. Sequence Diagram pada Form Peta

Serangkaian kegiatan saat terjadi event pada form peta dapat dilihat pada

gambar 111.4 :
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r FO FO

User Main form Form Peta

Menu ()
click form Peta ()

Tampilkan

Menu ()

database ()

\
\
\
\
\
\
:] Koneksi
\

Gambar 111.4. Sequence Diagram Form Peta
Keterangan :
Untuk melihat form peta, user terlebih dahulu berada di tampilan beranda atau

main form kemudian user mengklik form peta untuk melihat informasi peta.

2. Sequence Diagram pada Form Login
Serangkaian kegiatan saat terjadi event pada form login dapat dilihat pada

gambar 111.5 :

T O O O O

Administlrator Main form Form Login Proses Login Halaman
Website Administrator

Tampilkan Fom () D
F————————
Validasi nama

\
\
\
\
\
\
click form login D dan password ()
\
\
\

Menu ()

i)

‘ Invalid ()

Login sukses ()

S

Gambar 111.5. Sequence Diagram Form Login
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Keterangan :

Pada form login, saat berada pada main form admin mengklik form administrator
untuk melakukan login admin, kemudian admin menginput data username dan
password, sistem akan melakukan koneksi database untuk menyetarakan data
apabila data sesuai maka admin akan masuk kehalaman admin bila data gagal atau

tidak sesuai maka akan tampil pesan error.

3. Sequence Diagram pada Form Data Lokasi Akper dan Akbid
Serangkaian kegiatan saat terjadi event pada form Lokasi Akper dan Akbid

dapat dilihat pada gambar 111.6 :

: FO O O O

Administrator
Website

[ \ \
Tampilkan Fom () D ‘
>
\
\
Menu () |
click form ‘

kampus ()

Main form Form Data kampus Proses Db kampus

\
\
\
\
\
\
\
| updatedata() | oneksi database ()
Nk

(R —

‘ deletel data () i Koneksi database ()|

Close form () LL

\ \ \ \
Gambar 111.6 Sequence Diagram Form Lokasi Akper dan Akbid

Keterangan :
Pada form lokasi akper dan akbid, admin mengklik form kampus kemudian

melakukan update data, kelolah data akan otomatis tersimpan di database.
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4. Sequence Diagram pada Form Data Brosur
Serangkaian kegiatan saat terjadi event pada form brosur dapat dilihat pada

gambar 1.7 :

r FO FO O O

Administrator
Website

Main form Form Data brosur Proses Db brosur

1

Tampilkan Fom ()

4JMenu ()

click form

I I

I I

I I

' I I
I I

I I

brosur () =_ |
I

L

] —

| update data () Koneksi database_()_

B -

deletel data () _l Koneksi database ()|

[ U,

—

Close form ()

1
I
I
I
s |
| < I
T
I I
I I
I I

Gambar 111.7 Sequence Diagram Form Brosur
Keterangan :
Pada form brosur, admin mengklik form brosur kemudian melakukan update data,

kelolah data akan otomatis tersimpan di database.
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5. Sequence Diagram pada Form Data Artikel
Serangkaian kegiatan saat terjadi event pada form data Artikel dapat dilihat

pada gambar 111.8 :

r FO FO O O

Administrator Main form Form Data Artikel Proses Db konten
Website
B 1

Tampilkan Fom ()

4JMenu ()

I I

I I

I I

' I I
I I

I I

artikel () ] I
I

i

I click form

| | updatedata() | goneksi database () |
| il 1]
| T <

| | deletel data () | koneksi database 0
I

| e, [T

| Close form () “

I

I

|

|

II
I
I
I
I

Gambar 111.8. Sequence Diagram Form Data Artikel
Keterangan :
Pada form artikel, admin mengklik form artikel kemudian menguodate data artikel

yang akan dimuat sebagai berita.

6. Sequence Diagram pada Form Data Buku Tamu
Serangkaian kegiatan saat terjadi event pada form buku tamu dapat dilihat

pada gambar 111.9 :



Administrator
Website

1

Tampilkan Fom ()

Main form

] —

4JMenu ()

click form

Form Data Buku tamu

Bukutamu ()

Close form ()

s.l

update data ()

Proses

Koneksi database_()_

—

B

deletel data () _l

e L

Koneksi database ()I

[ U,

B

-
| <
I__I‘

II
I
I
I
I

Gambar 111.9. Sequence Diagram Form Buku Tamu

Keterangan :
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r FO FO O O

Db komentar

Pada form buku tamu, admin mengklik buku tamu kemudian admin dapat mengisi

dan menghapus data buku tamu tersebut.

7.

dapat dilihat pada gambar 111.10 :

Sequence Diagram pada Form Upload Gambar Kampus

Serangkaian kegiatan saat terjadi event pada form upload gambar kampus
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T RO OO O

Administrator Main form Form Upload Gambar Proses Db gambar

Website Kampus

D \ \
Tampilkan Fom () | ‘
\
[
Menu () ‘
\

I click form

Upload Gambar
Kampus ()

\
| upload data () _ | Koneksi databasel(_j

,,,,,,,, «————————
| deletel data () |Koneksi database ()|

Close form ()

Gambar 111.10. Sequence Diagram Form Upload Gambar Kampus

Keterangan :

Pada form upload gambar kampus, admin mengklik form upload gambar
kemudian admin dapat melakukan upload gambar sesuai kebutuhan, admin juga
dapat melakukan download gambar yang telah di upload dan menghapus gambar

tersebut.

8. Sequence Diagram pada Form Upload Gambar Artikel
Serangkaian kegiatan saat terjadi event pada form upload gambar artikel dapat

dilihat pada gambar 111.11 :
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T RO O O O

Administrator Main form Form Upload Gambar artikel ~ Proses Db thumbnail
Website

D \ \
Tampilkan Fom () ‘
D:‘Menu ()

I click form

I I I

I I I

| | |

| I |

| | |

'Ioad Gambar artikell | |

\
|
I
I
I
I
I
I
I

\
| upload data () _ | Koneksi databasel(_j

download data () ,Koneksi database ()

,,,,,,,, «————————
| deletel data () |Koneksi database ()|

Close form ()

Gambar 111.11. Sequence Diagram Form Upload Gambar Artikel

Keterangan :

Pada form upload gambar artikel, admin mengklik form upload gambar kemudian
admin dapat melakukan upload gambar sesuai kebutuhan, admin juga dapat
melakukan download gambar yang telah di upload dan menghapus gambar

tersebut.

111.3.2. Desain Sistem Secara Detail

Tahap perancangan berikutnya yaitu desain sistem secara detail yang meliputi
desain output sistem, desain input sistem, dan desain database.
111.3.2.1. Desain Output

Berikut ini adalah rancangan tampilan desain peta yang akan dihasilkan oleh

sistem:



SISTEM INFORMASI GEOGRAFIS LOKASI AKPER DAN AKBID

BERANDA | CAMPUS MAPS | ARTICLES | LIST OF CAMPUS | GUEST BOOK | ADMINISTRATOR

Peta SIG AKPER

Klik salah satu nama lokasi yang tertera pada menu di sebelah kiri, kemudian ik marka peta untuk melihat informasi lokasi vang tersedia.

Untuk mencan tempat, anda dapat menggunalkan form pencarian dibawah peta.

Bl

Nama Kamgus | | |

S1G AKPER
DESIGN BY Fitria Kasih
S1G AKPER © 2014 By Fitris Kazih

Gambar 111.12. Desain Tampilan Peta

111.3.2.2. Desain Input
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Berikut ini adalah rancangan atau desain input sebagai antarmuka pengguna:

1. Desain Form Login

Desain form login dapat dilihat pada gambar 111.13 :
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SISTEM INFORMASI GEOGRAFIS LOKASI AKPER DAN AKBID

BERANDA | CAMPUS MAPS | ARTICLES | LIST OF CAMPUS | GUEST BOOK | ADMINISTRATOR

Login Admin

wEENAITE

Pazzword ‘ ‘

SIG AKPER

DESIGN BY Fitris Kasih
SIG AKPER @ 2014 By Fitria Kasih

Gambar 111.13. Desain Form Login

2. Desain Form Data Lokasi Kampus

Desain form Data Lokasi Kampus dapat dilihat pada gambar 111.14 :

SISTEM INFORMASI GEOGRAFIS LOKASI AKPER DAN AKBID

BERANDA | LOKASI KAMPUS | BROSUR KAMPUS | OLAH ARTIKEL | UNGGAH GAMBAR KAMPUS | UNGGAH GAMBAR ARTIKEL | OLAH BUKU TAMU | KELUAR

Form Pengisian Lokasi Kampus

Alamat

Katerangan

Gambar Kampus ‘ Pilih Gambar - ‘

Koordinat | | : | | Peta

Nama Kampus "| | |

Gambar 111.14. Desain Form Lokasi Kampus
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3. Desain Form Data Brosur

Desain form Data Brosur dapat dilihat pada gambar 111.15 :

SISTEM INFORMASI GEOGRAFIS LOKASI AKPER DAN AKBID

BERANDA | LOKASI KAMPUS | BROSUR KAMPUS | OLAH ARTIKEL | UNGGAH GAMBAR KAMPUS | UNGGAH GAMBAR ARTIKEL | OLAH BUKU TAMU | KELUAR

Form Input Data Brosur

Kampus v
Sejarah

Fasilitas

Syarat Pendaftaran

Rincian Blaya

Jadwal Pendaltaran

Kontak Person

Gambar 111.15. Desain Form Brosur
4. Desain Form Data Artikel

Desain form Data Artikel dapat dilihat pada gambar 111.16 :



SISTEM INFORMASI GEOGRAFIS LOKASI AKPER DAN AKBID

BERANDA | LOKASI KAMPUS | BROSUR KAMPUS | OLAH ARTIKEL | UNGGAH GAMBAR KAMPUS | UNGGAH GAMBAR ARTIKEL | OLAH BUKU TAMU | KELUAR

Pengolahan Blog Website

Judul

Diterbitkan | Pilih w | Gambar | Pilih Thumbnail - |
Tambzh

| | [ ]

Gambar 111.16 Desain Form Data Artikel

5. Desain Form Data Buku Tamu
Desain form Data Buku Tamu dapat dilihat pada gambar 111.17 :

SISTEM INFORMASI GEOGRAFIS LOKASI AKPER DAN AKBID

BERANDA | LOKASI KAMPUS | BROSUR KAMPUS | OLAH ARTIKEL | UNGGAH GAMBAR KAMPUS | UNGGAH GAMBAR ARTIKEL | OLAH BUKU TAMU | KELUAR

Kirim Komentar Kepada Kami

Nama Anda | |

Email |

Komentar

Gambar 111.17 Desain Form Buku Tamu

6. Desain Form Data Upload Gambar Kampus

Desain form Data upload gambar kampus dapat dilihat pada gambar 111.18 :

47
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SISTEM INFORMASI GEOGRAFIS LOKASI AKPER DAN AKBID
BERANDA | LOKASI KAMPUS | BROSUR KAMPUS | OLAH ARTIKEL | UNGGAH GAMBAR KAMPUS | UNGGAH GAMBAR ARTIKEL | OLAH BUKU TAMU | KELUAR

Pilih Lokasi Gambar

Choose File | No fils chosen. |

Daftar Gambar Geografis Lokasi Akper dan Akbid

Gambar 111.18 Desain Form Data Upload Gambar Kampus

7. Desain Form Data Upload Gambar Artikel

Desain form Data upload gambar artikel dapat dilihat pada gambar 111.19 :

SISTEM INFORMASI GEOGRAFIS LOKASI AKPER DAN AKBID

BERANDA | LOKASI KAMPUS | BROSUR KAMPUS | OLAH ARTIKEL | UNGGAH GAMBAR KAMPUS | UNGGAH GAMBAR ARTIKEL | OLAH BUKU TAMU | KELUAR

Pilih Lokasi Gambar

Choose File | No fils chosen ‘

Daftar Gambar Untuk Blog

Gambar 111.19. Desain Form Data Upload Gambar Artikel

111.3.2.3. Desain Basis Data

Desain basis data terdiri dari tahap merancang kamus data, melakukan
normalisasi tabel, merancang struktur tabel, dan membangun Entity Relationship
Diagram (ERD).
111.3.2.3.1. Kamus Data

Kamus data merupakan sebuah daftar yang terorganisasi dari elemen data
yang berhubungan dengan sistem, dengan definisi yang tepat dan teliti sehingga
pemakai dan analis sistem akan memiliki pemahaman yang umum mengenai

input, output, dan komponen penyimpan. Kamus data penyimpanan sistem yang

akan dirancang dapat dilihat pada tabel 111.1 :
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Tabel.lll.1. Kamus Data

Data | Atribut Ekspresi Reguler Data
Brosur = | @kode_tempat + sejarah + fasilitas + syarat + rincian_biaya
+ jadwal + kontak
1. | kode_tempat = | {"[-+]?[0-9]}
2. | Sejarah = | {[0-9][a-z][A-Z][Spasi]}
3. | Fasilitas = | {[0-9][a-Z][A-Z][Spasi]}
4. | Syarat = | {[0-9][a-z][A-Z][Spasi]}
5. | rincian_biaya = | {[0-9][a-Z][A-Z][Spasi]}
6. | Jadwal = | {[0-9][a-z][A-Z][Spasi]}
7. | kontak = | {[0-9][a-Z][A-Z][Spasi]}
Gambar = | @id + name + type + size + content
1. |Id = | {"[-+]?[0-9]}
2. | Name = | {[0-9][a-Z][A-Z][Spasi]}
3. | Type = | {[0-9][a-z][A-Z][Spasi]}
4. | Size = | {"[-+]?[0-9]}
5. | Content = | {[0-9][a-z][A-Z][Spasi]}
jalan = | @Kode_Jalan + Nama_Jalan + Tipe Jalan + Lon + Lat
1. | Kode Jalan = | {"[-+]?[0-9]}
2. | Nama_Jalan = | {[0-9][a-z][A-Z][Spasi]}
3. | Tipe Jalan = | {[0-9][a-Z][A-Z][Spasi]}
4. | Lon = | N[-+]?[0-9]*\.?[0-9]+$
5 | Lat = | "[-+]?[0-9]*\.?[0-9]+$
komentar = | @Kode_Komentar + Nama + Email + Tanggal + Pesan
1. | Kode Komentar | = | {*[-+]?[0-9]}
2. | Nama = | {[0-9][a-Z][A-Z][Spasi]}
3. | Email = | {[0-9][a-z][A-Z][Spasi]}
4. | Tanggal = | {"[-+]?[0-9]}
5. | Pesan = | {[0-9][a-z][A-Z][Spasi]}
Konten = | @Kode_Konten + Tanggal + Terbit + Judul + Isi +
Thumbnail
1. | Kode_ Konten = | {"[-+]?[0-9]}
2. | Tanggal = | {"[-+]?[0-9]}
3. | Terbit = | {[0-9][a-z][A-Z][Spasi]}
4. | Judul = | {[0-9][a-Z][A-Z][Spasi]}
5. | Isi = | {[0-9][a-Z][A-Z][Spasi]}
6. | Thumbnail = | {[0-9][a-Z][A-Z][Spasi]}
kampus = | @Kode_Tempat + Nama_Kampus + Alamat + Telepon +
Gambar + Lon + Lat + Keterangan + Jurusan + Biaya
1. | Kode Tempat = | {"[-+]?[0-9]}
2. | Nama_Kampus | = | {[0-9][a-z][A-Z][Spasi]}
3. | Alamat = | {[0-9][a-Z][A-Z][Spasi]}
4. | Telepon = | {[0-9][a-z][A-Z][Spasi]}
5. | Gambar = | {[0-9][a-Z][A-Z][Spasi]}
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6. |Lon = | M-+]?[0-9]*\.?[0-9]+$

7. | Lat = | N[-+]?[0-9]*\.?[0-9]+$

8. | Keterangan = | {[0-9][a-Z][A-Z][Spasi]}

Thumbnalil = | @id + name + type + size + content

1. |Id = [ {7 [-+]?[0-9]}

2. | Name = | {[0-9][a-Z][A-Z][Spasi]}

3. | Type = | {[0-9][a-z][A-Z][Spasi]}

4. | Size = | {"[-+]?[0-9]}

5. | Content = | {[0-9][a-z][A-Z][Spasi]}

user = | @Id_User + Username + Password + Nama

1. | 1d User = | {"[-+]?[0-9]}

2. | Username = | {[0-9][a-z][A-Z][Spasi]}

3. | Password = | {[0-9][a-Z][A-Z][Spasi]}

4. | Nama = | {[0-9][a-Z][A-Z][Spasi]}

111.3.2.3.2. Desain Tabel

Setelah melakukan tahap normalisasi, maka tahap selanjutnya yang dikerjakan

yaitu merancang struktur tabel pada basis data sistem yang akan dibuat, berikut ini

merupakan rancangan struktur tabel tersebut:

1. Struktur Tabel Brosur

Tabel brosur digunakan untuk menyimpan data kode_tempat, sejarah, fasilitas,

syarat, rincian_biaya, jadwal, kontak, selengkapnya mengenai struktur tabel ini

dapat dilihat pada tabel 111.2 berikut:

Tabel 111.2 Rancangan Tabel Brosur

Nama Database fitria_akper
Nama Tabel Brosur
No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode Tempat int(5) Tidak Primary Key
2. | Sejarah text Tidak -
3. | Fasilitas text Tidak -
4. | Syarat text Tidak -
5. | Rincian_Biaya text Tidak -
6. | Jadwal text Tidak -
7. | Kontak text Tidak -
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2. Struktur Tabel Gambar

Tabel gambar digunakan untuk menyimpan data id, name, type, size, content,

selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.3 berikut:

Tabel 111.3 Rancangan Tabel Gambar

Nama Database fitria_akper

Nama Tabel Gambar

No Nama Field Tipe Data Boleh Kosong Kunci
1. |Id int(11) Tidak Primary Key
2. | Name Text Tidak -

3. | Type varchar(30) Tidak -

4. | Size int(11) Tidak -

5. | content longblob Tidak -

3. Struktur Tabel Jalan

Tabel jalan digunakan untuk menyimpan data Kode Jalan, Nama_Jalan,
Tipe_Jalan, Lon, Lat, selengkapnya mengenai struktur tabel ini dapat dilihat pada

tabel 111.4 berikut;

Tabel 111.4 Rancangan Tabel Jalan

Nama Database fitria_akper

Nama Tabel Jalan

No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode Jalan int(5) Tidak Primary Key
2. | Nama_Jalan varchar(30) Tidak -

3. | Tipe_Jalan varchar(10) Tidak -

4. | Lon Double Tidak -

5 | Lat Double Tidak -

4. Struktur Tabel Kampus
Tabel kampus digunakan untuk menyimpan data Kode Tempat,
Nama_Kampus, Alamat, Gambar, Lon, Lat, Keterangan, selengkapnya mengenai

struktur tabel ini dapat dilihat pada tabel I11.5 berikut:
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Tabel 111.5 Rancangan Tabel Kampus

Nama Database fitria_akper

Nama Tabel Kampus

No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode Tempat int(5) Tidak Primary Key
2. | Nama_Kampus varchar(25) Tidak -

3. | Alamat Text Tidak -

4. | Gambar int(11) Tidak Foreign Key
5. | Lon double Tidak -

6. | Lat double Tidak -

7. | Keterangan text Tidak -

5. Struktur Tabel Komentar

Tabel komentar digunakan untuk menyimpan data Kode Komentar, Nama,
Email, Tanggal, Pesan, selengkapnya mengenai struktur tabel ini dapat dilihat

pada tabel 111.6 berikut:

Tabel 111.6 Rancangan Tabel Komentar

Nama Database fitria_akper

Nama Tabel Komentar

No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode Komentar int(5) Tidak Primary Key
2. | Nama varchar(25) Tidak -

3. | Email varchar(25) Tidak -

4. | Tanggal datetime Tidak -

5. | Pesan text Tidak -

6. Struktur Tabel Konten

Tabel konten digunakan untuk menyimpan data Kode Konten, Tanggal,
Terbit, Judul, Isi, Thumbnail, selengkapnya mengenai struktur tabel ini dapat

dilihat pada tabel 111.7 berikut:

Tabel 111.7 Rancangan Tabel Konten

Nama Database fitria_akper

Nama Tabel Konten

No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode Konten int(11) Tidak Primary Key
2. | Tanggal timestamp Tidak -
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3. | Terbit varchar(6) Tidak -
4. | Judul Text Tidak -
5 |Isi Text Tidak -
6. | Thumbnail int(11) Tidak Foreign Key

7. Struktur Tabel Thumbnail

Tabel thumbnail digunakan untuk menyimpan data id, name, type, size,

content, selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.8

berikut:
Tabel 111.8 Rancangan Tabel Thumbnail

Nama Database fitria_akper

Nama Tabel Thumbnail

No Nama Field Tipe Data Boleh Kosong Kunci
1. |id int(11) Tidak Primary Key
2. | name Text Tidak -

3. | type varchar(30) Tidak -

4. | size int(11) Tidak -

5. | content longblob Tidak -

8. Struktur Tabel User

Tabel user digunakan untuk menyimpan data Id_User, Username, Password,

Nama, selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.9

berikut:
Tabel 111.9 Rancangan Tabel User

Nama Database fitria_akper

Nama Tabel User

No Nama Field Tipe Data Boleh Kosong Kunci
1. | 1d_User int(11) Tidak Primary Key
2. | Username varchar(12) Tidak Unique

3. | Password varchar(12) Tidak -

4. | Nama varchar(25) Tidak -
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111.3.2.3.2. ERD (Entity Relationship Diagram)
Tahap selanjutnya pada penelitian ini yaitu merancang ERD untuk
mengetahui hubungan antar tabel yang telah didesain sebelumnya, ERD tersebut

dapat dilihat pada gambar 111.20 :

syarat

e
username

brosur

1 <“Mengolah data 1
M
L 1 kampus
1

|

1

Memiliki 1

Nama_kamppus

Gambar

Kode_Konten

Tanggal

Kode_Jalan

Nama_Jalan

Konten

<0

Komentar

Tanggal

Thumbnail

Gambar 111.20 Diagram ERD Lokasi Kampus

111.3.2.4. Logika/Algoritma Program
Logika atau algoritma program pada penelitian ini menggunakan algoritma
tipe deskriptif. Algoritma yang akan dibuat dapat dipahami dengan langkah-

langkah deskripsi sebagai berikut:
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111.3.2.4.1. Activity Diagram
Bisnis proses yang telah digambarkan pada use case diagram di atas

dijabarkan dengan activity diagram :
1. Activity Diagram Melihat Peta

Aktivitas melihat peta diterangkan dalam langkah-langkah state, dimulai dari
kegiatan melihat panel peta kemudian mencari Artikel Lokasi Akper dan Akbid,
selanjutnya menekan tombol atau link yang ada pada peta dan yang terakhir
melihat informasi yang di sajikan dalam peta yang ditunjukkan pada gambar

11.21:

®
J

Halaman Utama

< Click Peta kampus >

Click Salah Satu marka kampus

< Melihat Informasi Lokasi kampus >

®

Gambar 111.21. Activity Diagram Melihat Peta

2. Activity Diagram Login Administrator Website

Aktvitas proses login admin diterangkan dalam langkah-langkah state,
dimulai dari memasukkan username, memasukkan password, jika profil valid
maka sistem akan mengaktifkan menu administrator, sedangkan jika tidak valid,

maka tampilkan pesan kesalahan yang ditunjukkan pada gambar 111.22:
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®

[ Memasukkan Username

L

[ Memasukkan Password j

i Valid invalid i

[Aktifkan Menu Administrator] [ Menampilkan Pesan Error ]

0

Gambar 111.22. Activity Diagram Login Admin

3. Activity Diagram Mengolah Data Lokasi Akper dan Akbid
Aktivitas proses mengolah data Lokasi Akper dan Akbid diterangkan dalam

langkah-langkah state yang ditunjukkan pada gambar 111.23:

*

( Form Lokasi Kampus

X

Pencarian Hapus

lTambah Editl
( Memilih Pencarian ) ( Mengisi Data J ( Memilih Data ) ( Memilih Data )

. . . Konfirmasi
(Mengetlk Kata Kunm) C Menyimpan Data ) C Mengubah Data ) C Penghapusan
( Menekan Enter ) Menekan Tombol) ( Menyimpan Data) ( Menghapus Data Da

Simpan

Tidak

(@)
Gambar 111.23. Activity Diagram Mengolah Data Lokasi Akper dan Akbid
4. Activity Diagram Mengolah Data Brosur
Aktivitas proses mengolah data brosur diterangkan dalam langkah-langkah

state yang ditunjukkan pada gambar 111.24:
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¢

( Form Lokasi Brosur

X

Pencarian Hapus

lTambah Editl
C Memilih Pencarian ) C Mengisi Data ) C Memilih Data ) ( Memilih Data )

(Mengetik Kata Kunci) C Menyimpan Data J C Mengubah Data ) ( Konfirmasi
Penghapusan

C Menekan Enter ) Menzl:fnnpz:mbolj CMenyimpan Data) C Menghapus Data \/ Ya

Tidak

(@Y

Gambar 111.24. Activity Diagram Mengolah Data Brosur

5. Activity Diagram Mengolah Data Buku Tamu
Aktvitas proses mengolah data Buku Tamu diterangkan dalam langkah-

langkah state yang ditunjukkan pada gambar 111.25:

¢

C Memilih aksi pada form Buku Tamu \

X

Tambah Hapus

( Mengisi Data ) ( Memilih Data )
\|, = fJ/ _ Tidak
C Menyimpan Data ) onfirmasi
Penghapusan va

M T ]
enekan Tombo ) C Menghapus Data \

Kirim

@

Gambar 111.25. Activity Diagram Mengolah Data Buku Tamu

6. Activity Diagram Mengolah Data Artikel
Aktvitas proses mengolah data Artikel diterangkan dalam langkah-langkah

state yang ditunjukkan pada gambar 111.26:
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¢

C Memilih aksi pada form Berita

X

Pencarian Hapus

lTambah Editl
( Memilih Pencarian ) ( Mengisi Data J ( Memilih Data ) C Memilih Data )

. . . Konfirmasi
(Mengetlk Kata Kunm) C Menyimpan Data ) C Mengubah Data ) C Penghapusan
( Menekan Enter ) Menesl?;np:ﬁmbolj C Menyimpan Data) C Menghapus Data Da

N

Tidak

(@

Gambar 111.26 Activity Diagram Mengolah Data Artikel

7. Activity Diagram Mengolah Upload Gambar Kampus
Aktvitas proses mengolah data upload gambar kampus diterangkan dalam

langkah-langkah state yang ditunjukkan pada gambar 111.27:

C\/Iemilih aksi pada form upload gambar,

kampus
Upload Delete
Download
Chose File > C Memilih data > C Memilih Data
K f Tidak
C Memilih gambar > C onfirmasi
Penghapusan
Ya
Menekan Tombol Menekan Tombol
Menghapus Data
upload download

®
Gambar 111.27. Activity Diagram Mengolah Data Upload Gambar Kampus
8. Activity Diagram Mengolah Upload Gambar Artikel
Aktvitas proses mengolah data upload gambar artikel diterangkan dalam

langkah-langkah state yang ditunjukkan pada gambar 111.28:
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@/Iemilih aksi pada form upload gambam

artikel
Upload Delete
Download
Chose File > C Memilih data > C Memilih Data >
C Mem|I|h gambar > C Konf|rma5| >Ij%
artlkel Penghapusan N
Menekan Tombol Menekan Tombol
Menghapus Data
upload download

®
Gambar 111.28. Activity Diagram Mengolah Data Upload Gambar Artikel

9. Activity Diagram Logout
Aktivitas melakukan logout admin dapat terlihat seperti pada gambar 111.29
berikut :

hd

Form File

N2
Click Keluar

L

[ Keluar Sistem

o

Gambar 111.29. Activity Diagram Logout

-/ U




